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Notification 

BroadSoft BroadCloud has been renamed to Cisco BroadCloud. You will begin to 
see the Cisco name and company logo, along with the new product name on the 
software, documentation, and packaging. During this transition process, you may 
see both BroadSoft and Cisco brands and former product names. These 
products meet the same high standards and quality that both BroadSoft and 
Cisco are known for in the industry. 
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About Mobility for Desktop 
Mobility for Desktop is a native Windows or Mac OS client for Unified Communications, providing 
the following communication features: 

 Instant Messaging and Presence

 Voice Calling (VoIP)

 Voice Calling (Desk phone) 

 Video Calling

 Desktop Sharing

 BroadWorks Call Settings

Get Started 

This section contains the essential information for getting started with Mobility. End users must 
ensure they are using valid drivers for video (for example). Additionally, end users must make sure 
to always use the latest OS version with latest security updates. 

Installation 
Your service provider provides the download of the installer. 

Windows 
 Double-click the Msi installer executable and follow the installation instructions.

 Launch Mobility.

Mac OS
 Double-click the disk image.

 Copy the application into the Applications folder.

 Launch Mobility.
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Sign In 
When you first launch the application, you are prompted to sign in. 

Note: Service providers define which login flow is used, so the process may or may not include 
all of the steps provided below. When login regions are enabled by your service provider, the 
login flow is typically as follows: 

NOTE: If you choose automatic sign in, you are automatically signed in and taken to the Main
window upon subsequent Mobility launches. Otherwise, you are presented with the Sign In screen
when launching the application. In the Main window, your default tab when signing in depends on
service provider configuration; otherwise, Mobility remembers the tab you were on
at sign out and opens that same tab at sign in.

The Login window offers the last used username, but the password shall be
automatically filled in only if you have checked the Save password check box. This
checkbox is only available in non-SSO deployments. If multiple people use the
same machine, only the last password is entered as a security measure. If you change
the username in the Login window through editing it, or using the drop-down list to pick
another one, Mobility will not fill in the password; you are always expected to type it in.
This also applies when re-selecting or re-entering the last used username.
If the DM URL is changed, the password is not remembered as a security feature.
After logging in, a pop-up dialog may appear informing you about emergency calls, and 
another about changing your location for emergency calls. You may also see a banner
in the Main window related to emergency calls. Depending on your service provider
settings, emergency calls may not be allowed. In this case, calling an emergency
number displays a pop-up dialog. A notification message in the Main window may also
display. It is not a supported configuration to run many Desktop clients at the same time
with the same account.

     NOTE: It is possible to run several Mobility instances at the same time, but headphone
  connectors and Outlook integration may not work as expected.
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1) If login regions for multi-XSP/multi-servers are enabled: Click Options      and select
your region/server from the drop-down menu.
 Select Momentum Server 2 if your organization's account ID starts with 3900...
 Select Momentum Server 1 if your organization's account ID starts with any other

numeric combination
 Contact your organization's System Administrator for assistance with choosing a

server
2) Enter your BroadWorks user name and password (in PIV mode, only a PIN is needed).
3) Select whether you would like Mobility to remember your password.
4) Select whether you would like Mobility to sign you in automatically on

subsequent launches.
5) Click Sign In.

Optional: In Release 22.5.0 and later, depending on your service provider configuration,
you may also have to enter your email address or access code with user name and
password and after that select the IdP. You can also access Help, Options/
Preferences, and login URL change view directly from the Login window.



Main Window 
When you start Mobility for the first time, your Contacts list is empty. Use the Search and 
Dial field to find people and add them to your Contacts list. Contacts can also be added 
manually by clicking the Add button. Note also, that depending on your service provider 
settings, the order of the left pane icons can vary. The left pane Call Settings icon and 
menus are visible depending on your service provider settings. The dial pad is also 
integrated with the Main window history tab. 

Mobility uses tabs for new chat sessions. The Search field allows searching for contacts. 
SIP URIs can be used in contact cards and must use the format user@domain or 
sip:user@domain. The table that follows the images describes the key icons used in the 
Main windows. 

Icon Usage 

My Information – View and update your information, for example, your presence, 
avatar, and location. 

Contacts – View your contacts. 

My Room – This is your permanent communication room. Participants can dial in to 
your audio bridge. 

Call History – View previous calls. 

Chat History – View previous chats. 

Dial Pad – Make calls (it is integrated with the Main window). 

Web Button – Provides web content inside the Main window or browser. 
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Icon Usage 

App Hub – Provides micro-apps and contextual intelligence to chat tabs. 

Preferences – Use for quick access to preferences and Call Settings such as Call 
Forwarding. 

Chat – Start an instant message conversation with a selected contact. 

Call – Make an IP audio call to a selected contact. 

Call from Phone – Make a Click To Dial call from your desk phone (or secondary 
device). 

Video Call – Make a video call to a selected client (VoIP). 

Share – Share either the whole screen or an individual application. 

Menu – Open Communications options. 

Add – Add a contact, group, or conference. 

My Information 
Click the avatar to update your status or location and enter free text. 

Presence 
You can set your presence to one status indicated in the following table. 

Icon What it means 

Automatic presence: This is the Available status where automated presence statuses 
such as Busy In-call override the Available status. Requires newer presence server 
(aggregated presence) to show. 

The green presence icon indicates that the user is online and ready for communication. 
This status is used until you change it and automated presence statuses such as In Call 
do not override. 

The yellow presence icon indicates that the user is online but has been idle or away from 
their computer for more than ten minutes. 

The red presence icon indicates that the user is busy and does not want to be disturbed. 

The grey presence icon indicates that the user is offline, and the only available contact 
method is calling or leaving a chat message. 

This icon indicates that the contact is busy on a call. This is an automated presence 
status. 

This icon indicates that the contact is busy in a meeting. This is an automated presence 
status. The Busy – In Call status overrides the Busy – In Meeting status so this one is 
only seen if there is a meeting but no call. 
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Mobility can automatically update your presence to the following: 

 Busy – In Call

 Busy – In Meeting (Windows only)

 Available (desk phone) 

 Available (mobile)

 Away on mobile

 Offline and busy in call

Location 
Your location is automatically determined by your public IP address; however, 
you can manually set the text to appear for your location and time zone using 
the location dialog box. 

Communications View 
After starting communication with one or more contacts, a new tab is displayed for chat. 
The call window is also integrated with the Main window chat tab by default. You can 
separate a tab on to a different Communications window by using the pop-out button in 
the Main window. From this view, you can perform the following actions: 

 Escalate a chat to include audio, video, and desktop sharing

 End an audio or video call

 Open the dial pad

 Mute your microphone

 Adjust your speaker volume

 Place a call on hold

 Transfer a call

 Toggle between speaker and headset. You must specify different
devices for a speaker and a headset in Preferences to use this feature.

If you are using several monitors, Mobility opens the Communications window as well as 
notifications on the same monitor as the Main window. 

Starting with Release 21.2.0, Mobility limits the number of active communications to 
spare resources. The limit is 20 active communications on Windows and on Mac OS. If 
the maximum is reached, the main window’s top section warns user with the following 
message: “The maximum amount of communication windows has been reached. Please 
close some to open new ones.” 

If an incoming call is answered while this warning is shown, the client closes the chat 
session that has the longest time since its last activity. 
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Start Chat 
Start a chat tab using one of the following methods: 

 Double-click a contact from the Contacts list or search results. This can be
changed to single click in preferences by changing to the single-click mode.

 Right-click one or more contacts from the Contacts list or search results and click the
Chat menu item.

 On the Chat History list, double-click a chat entry.

 In a Communications window, click the Chat button (this does not open a new tab).

 In the Main window, click the Add button and in the resulting tab click the Chat icon.

Send File 
In a one-to-one chat, transfer files by clicking the Send File button in the Communications 
window or by using the “drag and drop” method so that they are moved to the 
Communications window. 

Send Email 
Right-click a contact from the Contacts list or search results and select the Email menu 
option. The contact must have an email address defined for this feature. 

Make Audio or Video Call 
Make an audio or video call using one of the following methods: 

 Right-click one or more contacts from the Contacts list or search results and
select the Call, Call from Phone, or Video menu item. The menu items
depend on service provider settings.

 Hover over the contact list avatar and select one of the audio or video call buttons.

 Open the dial pad, enter a phone number, and then click the Call, Call from
Phone, or Video button.

 On the Call History list, double-click a call entry.

 In the Communications window, click the Call, Call from Phone, or Video button.

 When viewing a contact’s profile, click the Call, Call from Phone, or Video button.

Share Your Application or Desktop 
Share your desktop by following these steps: 

1) Click the Start Sharing button in the top of the Communications window (if
share panel is not visible). The Share button is visible by default in My Room
also if your service provider has enabled share on your account.

2) Select the application to share or the entire screen of a particular display and click the
Start Sharing button.

NOTE: If dialing a phone number that requires additional dual-tone multi-frequency (DTMF) 
tones (for example, a conference bridge), you can type the numbers on your keyboard while the 
Communications tab has focus or open the dial pad in the Communications tab. 
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In addition, participants can also share when enabled by their service provider. 

Active Communications 
Active communications appear at the top of the Contacts list in the Main window (native 
Desktop only). This area provides an easy view to see the people with whom you are 
communicating. By default, starting in Release 20.1.0, there is no separate call tab but 
call is shown in the Active Communications area in the Main window (where the call can 
be fully controlled in the Desktop client). It reduces the number of Communications 
windows; however, a separate call window can still be opened using an Active 
Communications menu. The following is also available in this area: 

 Double-click an active communication item to bring this Communications tab
to focus if the call window is separately shown. If the call window is
integrated, you can use the pop-out button to show it separately.

 End a call.

 Mute the microphone.

 Place a call on hold.

 Merge two calls or transfer by dragging and dropping calls onto each other.

 Transfer a call.

 Make conference calls.
 Park and retrieve calls.
 Set audio device to headset or speaker. For more information, see the

Preferences section.
As a service provider option, more buttons can be added to the active Communications 
area: 

 Conference

 Call Transfer

 Call Park

 Call Pull

When enabled, you can use these buttons for faster access to services. 

You can right-click the “More” icon of an active Communications item (icon with three dots) 
for additional options while a left-click offers additional call management options for this 
call as well as other options when available. 

NOTE: To share your desktop, you must enter your web collaboration credentials in 
Preferences → Credentials, unless your service provider has automated provisioning in use. 
For more information, see section Preferences. You can participate in desktop sharing 
sessions by another user even without having your own sharing credentials. 
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My Room 
My Room is an always available and permanent space you can use to group chat with 
anyone that enters if the provider or organization enables it for use. 

If you assign a conference bridge to your profile in Options > Advanced > Credentials, 
then in your room, you and your attendees can click the Call or Video button to have 
Mobility automatically dial in to the conference and enter the appropriate entry codes. 
Note, if your service provider has auto-provisioning enabled, then you cannot edit these 
details. If your service provider has silent dialing enabled, then you cannot hear any 
DTMF tones when dialing into My Room (the call is made automatically). 

If a conference bridge is not specified, you cannot initiate a call while in your room. 

You can invite others to your room by dragging and dropping them from the Contacts list 
into the My Room tab. You can also use the right-click menu on the My Room icon in the 
top-right corner of the Main window or the My Room information area to copy an 
invitation link for guest users (people without Mobility). They can then click the link and join 
the meeting through a web browser. Guest users must be separately accepted for each 
session. 

Contacts join your room by right-clicking your name on their contact list and selecting Join 
Room or by an invitation you sent. 

Email My Room Invitation menu results in working links for guest users and Mobility users 
if enabled by your service provider. Mobility users are recommended to use “Copy Guest 
Link” invitation links; however, the btbc links (when enabled by your service provider) 
may not work in all applications as they were originally intended for Outlook. 

You can also export the attendee list using the related participant menu available via the 
options icon (three dots). 

In My Room calls, the owner can also see active speaker info with the Mute/Unmute icon. 

My Room can also be moderated, for more information on moderation, see the 

Moderator Controls section. 

My Room calls cannot be conferenced or transferred. 

In Options → General tab, you can select to use an external Webex Meetings app for 
your My Room sessions. In that case, there is no synchronization of events between 
Mobility and Webex Meetings. 

Select Audio Devices 
If you have multiple audio devices available for your microphone or speakers, 
select the preferred audio device before starting a call. 

Windows 
1) Click the Mobility logo or File in the Main window title bar.

2) Select Options.

3) Select Audio.

4) Set a playback device (speakers).

5) Set a recording device (microphone).

6) Click OK.
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Mac OS 
1) Select Mobility or File from the main menu.

2) Select Options.

3) Select Audio.

4) Set a playback device (speakers).

5) Set a recording device (microphone).

6) Click OK.

If “Use default” is selected, then Mobility uses the default device set in the 
operating system preferences. For Windows, if “Default Communication Device” 
is defined, it is selected over the “Default Device”. If you are using headsets, you 
can also select a separate device than the headset for alerting incoming calls. 

Note that on Mac OS, it is recommended to disable “Use ambient noise 
reduction” in System Preferences to reduce echo. For more information on USB 
headset support and settings details, see section Headset Support. 
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Contacts 

Contacts are the people with whom you communicate and, in most cases; you see their 
presence and share your presence with them. There are three types of contacts: 

 Contacts – Actual people with whom you communicate.

 Conferences – Audio or video conference bridges that you use to communicate with
others. Silent dialing into the bridge also applies to these contacts if enabled by your
service provider. Conference contacts are regular contacts and are added just like
regular contacts.

 Groups – Containers of contacts and/or conferences.

There is no hard-coded limit on the number of contacts. The more contacts are added, the more 
memory and processing is needed. The more contacts are added, the more difficult it is to find 
people without searching. Live search can be used instead of a very large local contact list while 
keeping memory and processing requirements to a minimum. 

Add 
When you sign in for the first time, there are no contacts on your contact list. Add a new 
contact at any time by selecting the Add Contact item from the menu or choose the Add 
button from the Main window (+ icon). In the resulting tab, you can select to add a contact, 
group, or other items. 

In the Add Contact tab, enter the contact’s information and then click Save. By default, 
your presence information is always shared with a new contact if an Extensible Messaging 
and Presence Protocol (XMPP) address is provided. 

If you are accepting contacts via a buddy request, you may see the contact card after 
accepting the buddy request, depending on the service provider settings. When receiving 
a buddy request, there are two buttons for accepting and rejecting the request. 
Dismissing the buddy request window only ignores the request for the duration of the login 
session. It reappears after the next login. 

However, you can always share your presence information later by selecting Subscribe on 
the right-click menu for a specific contact in the contact / directory list. Note that the 
contact must accept your subscription request for you to establish the presence 
relationship successfully. 

The newly added contact appears on your contact list. 

Add a conference contact by clicking the same button you did for Add Contact. A 
conference contact is a special contact used for conference bridges to avoid remembering 
PIN codes and conference number, for example, recurring conferences. Just create a 
contact for the weekly conference, add a conference bridge number and PIN, and join the 
conference just by right-clicking the contact or choosing it and clicking the Call button. 

Choose the Add Group menu option to add a new group to the contact list. 

Contact card telephone number fields can also have SIP URIs (work, mobile, extension, 
personal, and conference bridge). Release 21.5.0 introduced support for additional 
contact card fields. 
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Edit 
Edit a contact by selecting the contact first. After you select the contact, right-click 
anywhere in the area of the selected contact and a menu of options appears which allows 
you to either view or edit the contact profile. In View mode, click the Edit button to go to 
Edit mode. This base principle is the same for normal contacts, conference contacts, and 
groups. Note that depending on your service provider settings all or no contact card fields 
may be editable. Depending on your service provider settings, you may also see a button 
for synchronizing the contact card with the Telephony Directory or the synchronization 
may take place automatically (native Desktop only). When the manual synchronization 
button (cloud icon) is visible, there is no automated syncing of the contact card details with 
server information. To synchronize the contact card data, click on the cloud icon. 

 Unsubscribe removes the presence relationship between you and that contact.
This means you do not see the contact’s presence information and your
contact does not see yours. To re-establish the presence relationship, select
Subscribe. An unsubscribed contact remains on the contact list and is always
shown without an icon. Any contact that is not presence-enabled is shown in
the same way.

 Delete contact removes the contact from your contact list.

 View Profile opens the Contact Information dialog box where you can add,
edit, or remove information. This works for both normal and conference
contacts.

 For groups, choose the Edit menu option to rename a group. Once done with all
changes, click the Save button.

Filters 
You can filter contacts in two ways: 

 Use the filter field to search by contact name. The contact list is filtered in real
time as you type.

 Alternatively, use the filter menus available by right-clicking the Contacts icon
in the left pane to display only specific types of contacts such online contacts.
You can also sort contacts based on first or last name or choose whether to
display the contact’s avatar and availability status in the contact list.

Favorite filtering works slightly differently in Release 21.2.0 and later: 

 When you make a contact your favorite, the favorite group shows on
top of the contact list and cannot be hidden.

 When you delete all your favorite contacts, the favorite group does
not show anywhere.

 When you have even one favorite marked, you see the group.
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Presence 

For each contact you have subscribed to, you can see their presence. Similarly, your contacts can 
see your presence on their contact list. 

Presence means that your friends are able to see whether you are available to communicate, for 
example, “I’m busy” or “I’m available”. 

Icon What it means 

Automatic presence: This is the Available status where automated presence statuses 
such as In-call override the Available status. Requires newer presence server to show. 

The green presence icon indicates that the user is online and ready for communication. 
This status is used until you change it and automated presence statuses such as In Call 
do not override. 

The yellow presence icon indicates that the user is online but has been idle or away from 
their computer for more than ten minutes. 

The red presence icon indicates that the user is busy and does not want to be disturbed. 

The grey presence icon indicates that the user is offline and the only available contact 
method is calling or chatting. 

The question mark indicates that a subscription is pending and the contact has not yet 
approved sharing their presence. 

This icon indicates that the contact is busy due to a call. This is an automated presence 
status. 

This icon indicates that the contact is busy due to a meeting. This is an automated 
presence status. The Busy – In Call status overrides the Busy – In Meeting status so this 
one is only seen if there is a meeting but no call. 

This icon indicates that the contact is only available on the Mobility smart device application. 

This icon indicates that the contact is only available on a compatible desktop phone, and 
not Mobility. 

This icon indicates that only the mobile client is online and in the away status. 

This icon indicates that the user is in a call but is not logged in to XMPP (presence and 
chat). 

The avatar in this version is not completely in real time. The avatars are retrieved at login, when 
the contact is added, and when the contact comes online. Double-click the avatar to change your 
avatar. A File Explorer view opens. 

If you see an error message at the top of the Main window “XMPP Unavailable”, it means that the 
XMPP connectivity has been lost for chat and presence; however, you can still make calls. You 
should contact your service provider. 

Have the Outlook calendar automatically change your presence to Busy – In Meeting by 
enabling this in the Options → General tab (native Desktop only). 

The presence update is only triggered by appointments and meetings that are in the Show me as 
busy state. 

The XMPP address of a contact cannot be changed. Instead, you must delete the old contact 
and create a new one. 
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Location in presence is done based on the IP address that the machine is using on Windows. The 
IP address is mapped to a physical location. Cisco (formerly BroadSoft) is working with the 
mapping provider to improve the accuracy of the location. On Mac OS, the operating system 
location is utilized. You will be prompted to accept location usage. Change the location manually 
by clicking the avatar (if presence controls are not already expanded) and then the location icon to 
go to the manual location and change the view. 

Snapshot of presence status is also available in search results and Communications window 
for contacts who are not buddies. This presence status is not updated after the search is done 
or after the communication session is set up. 

Chat 

Automated Presence 
As a service provider option starting in Release 22.5.0, automated presence may be used. 
When used, contact addition no longer uses a buddy request dialog instead all presence 
subscriptions are automatically accepted by the network. This results in asymmetric 
presence relationships where you see the presence of the contacts you have added but 
they do not see your presence until they add you as a contact. This feature requires a 
newer server version (aggregated presence) to show. 

Chat View 
When you initiate a chat, the Chat tab inside the Main window opens. Chatting with a 
contact is possible only when you are both online. If your contact initiates a chat, you see 
a pop-up notification in the bottom right-hand corner of the screen. If you close the Chat 
tab and open it again, sent chat messages are shown in the tab as chat history. When 
enabled by your service provider, a typing notification is also shown. 

When the chat opens, you see the contact’s information at the top of the screen. 

In the text field, you can add a smiley emoticon. Smiley emoticons can also be added by 
manually entering the corresponding characters that represent that particular emoticon. 
You can send text by pressing ENTER. 

The full set of Emojis is also supported and they are rendered as ordinary emoticons when 
received. Spell checking in US English is also supported and can be disabled in 
Preferences. The implementation of Emojis is different between Releases 22.1 and 22.4 
and later so sending Emojis between those may not fully work. For troubleshooting tips, 
see section Troubleshooting. 

To enter a line break in the text field, you can use the following key commands: 

 CTRL+ENTER (command+enter on Mac)

 SHIFT+ENTER

 ALT+ENTER

Use either one of the short commands, CTRL+C or CTRL+V, or right-click the selection 
for a menu to copy or paste the text to or from the Chat tab. 

It is also possible to chat with users in other domains. BroadCloud also supports Google 
federation. Group chat is not supported in Google federation, so the group chat option 
with these contacts is shown in grey. 
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All sent and received chats are stored locally in the chat history and an optional message 
history feature provides multi-device enhancements so that messages sent or received in 
other own devices would also be shown. 

Depending on your service provider settings, older chat messages may be automatically 
deleted. In this case, the history links in the top area of the Chat view are automatically 
adjusted. 

File Transfer 
File transfer functionality is only accessible through the Chat tab. 

1) To open the File Selection dialog box, click the Send File button located to the
side of the text field.

2) From the dialog, select the file to be sent, and then click Open. You can
also drag and drop a file into the Chat tab.

3) Once the file offer is issued and during its transfer, you can cancel the transfer
(at any time) by clicking Cancel.

4) Accept an incoming file transfer by clicking the Accept button.

5) Reject the file transfer offer by clicking the Decline button.

After the file transfer has completed, the received files can be opened or viewed in the file 
manager by using the File received, click to open, and Show in folder links. 

In error situations, partially received files are not deleted automatically. 

Group Chat 
Start a group chat by “multi-selecting” and right-clicking the Main window contact list or by 
expanding a 1-1 chat into a group chat using drag and drop or by having a multi-party call. 
More people can be added later to the chat by drag and drop. Only the owner can add 
more participants. However, these options depend on your service provider settings. 
Depending on your service provider settings, the right-click menu items may differ. Newer 
group chat deployments only have the My Room right-click menu item available for calls. 

A group chat works the same way as a one-to-one chat in a tabbed view. All messages 
from anyone are sent to everyone else. All contacts need to be online to be able to 
participate in a group chat. You cannot invite an offline contact or a contact that is not on a 
device that supports group chat. This does not affect the group chat in any way. 

A group chat history is saved both in My Room and in ad hoc chat rooms and is available 
to view later in the Messages tab of the Main window. 

In the text field, the contacts’ names appear in different colors to easily distinguish 
between who is writing. 

Only the newest chat room messages are stored on the server. One-to-one chat 
messages are only saved locally. When the optional Message History feature is enabled 
by your service provider, messages sent from your other devices are also shown. 

Deleting a chat room is not supported. 

Chat rooms can be moderated by the owner. Use the right-click menu options to remove 
a participant from your chat room. If needed, the removed participant can join later. The 
removal also applies to desktop share sessions. 

Typing notifications are not supported in group chats. 

MOBILITY DESKTOP USER GUIDE

19



Release 21.5.0 introduced support for receiving group messages sent from Mobility while 
Release 22.4.0 added support for also initiating group messaging sessions. New group 
message threads are created using the New button (+ icon in the Main window) and in 
the opened view selecting chat discussion participants and then sending at least one 
message to the selected participants. Alternatively, you can multi-select contacts and start 
a group messaging session in that way. 

Audio and Video Calls 

The following table describes additional Communications window icons and explains what you can 
do with them, for voice and video calls. 

Icon What you can do 

Add or remove video from the call. 

Mute your microphone by clicking the mute icon. 

Put the call on hold. Note that if you hold the call, the other party cannot “unhold”. This 
freezes a video call to the last frame of the video feed. In both voice and video calls, 
this is communicated to all parties by a notification appearing in the middle of the 
screen. 

Use this icon to access the Call Options menu. In the Call Options menu, you can find 
different actions to use for a call depending on your settings and your service provider. 

In the Options menu, there are the following options: 

 Transfer a call to a third party.

 Put the call on hold. Note that if you hold the call, the other party cannot “unhold”. This
freezes a video call to the last frame of the video feed. In both voice and video calls,
this is communicated to all parties by a notification appearing in the middle of the
screen.

 Adjust the volume bar to adjust the volume. Dragging it all the way to the left mutes
your speakers.

 Enter additional digits using the dial pad at any time during the call (for example, to
insert a conference number). The dial pad is not movable.

 Toggle between the audio headset and speakers. You must specify a different device
for a headset and a speaker in Preferences to be able to use this feature.

 Add participants to the call.

As an alternative, in general, available Feature Access Codes (FACs) for call 
management work during calls, for instance *55 for direct transfer to voice mail, but the 
ongoing call must be put on hold and a new call must be made to the FAC number. Using 
DTMF for the same purpose does not work. 

When establishing a call to a contact, you can choose several ways to call. Right-click the 
contact you want to call and select the Call menu item. You can choose the number to call 
from a right-click menu. There can be several phone numbers available in the menu. The 
work phone is the default and top-most number is followed by mobile and other numbers. 
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This also applies to the transfer and conference windows. However, in certain cases, the 
transfer/conference default number can differ from other call options in other menus. 

The default call type can also be selected using accessibility menus (Calls → Dialing 
service). This controls the default call type when using call buttons. 

Dial a number or SIP URI of format user@domain or sip:user@domain in the combined 
Search and Dial field to make a call (native Desktop only). Once you type your numbers, 
Mobility searches for contacts on both the local contact list and the enterprise directory. 

You can also call circuit-switched network numbers such as Global System for Mobile 
Communications (GSM); however, this depends on the service provider network you are 
using; there is no technical limitation. 

Choose your video size from the Preferences and the Video tab. Your selection is used by 
default for future video calls. The available sizes are automatically presented based on 
your camera. 

You cannot have two simultaneous calls with the same person. 

Mobility does not add video to an audio call without end-user consent. This also applies to 
blind video call transfer cases where audio-only music on hold is used; this may result in 
the transferred call being reduced to audio. 

You can also see a secure call icon when an encrypted call is taking place. 

Call From Computer 
Select a contact from your contact list to start communication and click the desired 
communication button. To communicate with someone who is not on your contact list, 
type a phone number in the Dial pad view. 

Call From Phone 
The second option to communicate in the row of communication buttons is the Call 
from Phone. When you click this button, the desk phone instantly starts ringing and the 
call is established from your desk phone. This depends on your service provider 
configuration as other devices may also ring. 

When your service provider is configured to also initiate a call from computer (SIP call) to 
the same machine that initiated a call from phone, that incoming (SIP) call will be accepted 
and will alert if it does not have the same identity as the call from phone. 

For remote calls initiated using Mobility, you can also have mid-call controls such as 
hold/resume, transfer, and add participant. 

Automatic Busy – In Call presence also works with the Call from Phone feature. 

Depending on your service provider settings, it is also possible to control calls initiated 
without Mobility in the Active Communications view. The same mid-call controls are also 
available in this case. In case of an incoming call, the actual answering action must 
happen with the other device. 

NOTE: There is sleep prevention during calls. 
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Answer Call 
When someone is calling you, you see a pop-up notification on your screen. You can 
choose to answer, silence the incoming call, and then open a chat session with the caller, 
reject the call, or silence the incoming call by closing the pop-up notification window. If you 
silence the call, the ringtone is silenced but the caller does not see anything on their end. 
You can answer or reject the call after silencing it only if you have chosen the chat option. 
If you close the incoming call pop-up notification to silence an incoming call, then you do 
not have an option to answer or reject it any more. When choosing the chat option, chat is 
only enabled after the call has been answered or rejected. 

If you reject the call, it causes the line to sound busy at the caller’s end and they know that 
you rejected the call. 

When someone is calling you with a video, you see the same pop-up notification; 
however, the options are answer with video, answer as voice only, silence and chat, 
reject, or silence (by closing the pop-up window). If you decide to answer as voice only, 
the call is voice only. 

Priority Alert 
The Priority Alert feature is also supported depending on your service provider 
preferences. Priority alerting/distinctive ringing allows you to provision call criteria in a web 
portal to provide a distinctive ring or call waiting alert tone when a call is received that 
meets the criteria. The criteria may include information such as the calling line 
identification, time of day, day of week, and so on. 

Contact Name Lookup for Incoming Calls 
Mobility performs a local contact search for incoming calls. If the number matches one of 
the contacts on the Mobility contact list, the name is shown on the incoming call screen 
along with the alert. Both the display name and phone number are shown when 
available. 

If there is no match to a local contact, Mobility looks for a match in the Telephony 
Directory and other available directories, and if a match is found, the available information 
is shown for the incoming call. If there is no match in the Telephony Directory, the display 
name is taken from the available information in the incoming call. 

Whenever you retrieve your call logs/history, Mobility does a lookup in the local contacts 
and populates the name if a match is found. 

Missed Call or Communication 
When you have one or more missed calls or other types of communications, there is a 
notification on the left-hand side of the navigation pane in the Main window. Clicking the 
icon takes you to the missed communication in the Communications History view. 

Full Screen in Video Call 
Full screen mode can be activated by clicking the Full Screen button or by double-clicking 
anywhere on a video. 

Exiting full screen mode is done by pressing the Esc key (on both Windows and Mac OS) 
or by double-clicking the window. Exiting full screen makes the video call go back to its 
original state (even if there was resizing of the window previously before going full screen). 

In a full-size window, you can see a similar Options menu at the top. It has the same 
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functionality as it does in the normal view. When you move the mouse, the top bar and 
lower communication buttons appear on top of the video. 

Multiparty Sessions 
You can have many participants in a call, either in a My Room or in an ad hoc multiparty 
call (native Desktop only). Add more participants by dragging and dropping them on to the 
Communications tab or by selecting the Conference menu item via the Communications 
tab menu button. By choosing the menu item, you can also add participants with just a 
telephone number. Starting with Release 22.2.0, ad hoc multiparty calling is slightly 
different in that each call party must be separately merged onto the call to be able to 
terminate failing calls to, for example, voice mail. 

In contrast to using My Room, which uses your permanent chat and collaboration rooms 
and conference bridge, you can start ad hoc multiparty sessions by either selecting 
multiple contacts on the contact list and starting a chat, by calling them, or by expanding 
a one-to-one session into a multiparty session by dragging and dropping a contact into 
the Communications window. In an ad hoc session, the room used is a temporary one 
that is deleted once the session ends (that is, when the last participant leaves). Voice 
conferencing does not use a bridge but instead uses the BroadWorks N-Way Calling 
supplementary service in a sequential fashion. Mobility dials out to all participants and 
takes everyone off hold after the last attendee answers. 

In newer deployments with the Video Server (UVS), the ad hoc room created for the 
session has a limited lifetime and becomes inactive when idle for too long. In this case, 
participants are able to rejoin the ad hoc session if they drop out for some reason. A 
consequence of this is that, in ad hoc group calls, participants who are no longer in the call 
are still visible in the participant list. 

If the XMPP service is not available, then ad hoc multiparty calls are not available. 

Call Waiting 
You can have one active call at any one time if you receive a new incoming call and 
accept it. The existing call is put on hold and you can change between these two calls by 
using the Hold and Unhold buttons. 

If Call Waiting is in the ringing state, then new incoming calls are rejected. 

Call Transfer 
Blind call transfer is available in the Communications window; choose the Transfer Call 
menu item to transfer the call to someone else (native Desktop only). Attended call 
transfer is also available in the same window, first call someone to check if the called party 
can take the incoming call and then transfer the incoming call to the desired called party. 
You can also search for the transferred-to party. 

Message Waiting Indication and Visual Voice Mail 
Depending on your service provider settings, you can have either Visual Voice Mail 
(preview feature for video) or Message Waiting Indication (MWI) view in your client. 

The MWI service allows you to receive a notification for a waiting voice mail or video mail. 
By clicking on the message icon in the upper part of the Main window, Mobility calls the 
predefined mailbox number to allow the user to listen to the voice mail or view the video 
mail. With this view, you only have two history tabs: one for calls and another for chat. 
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It is also possible to call voice mail from the dialer by long pressing the “1” icon in the 
dialer. 

When visual voice mail is enabled, a third tab is available, showing visual voice mails. Click on 
individual mails to listen to them. Video mail is supported as a preview feature if enabled by 
your service provider. The current design is that listening to the visual voice mail or marking it 
as read decreases the unread messages badge while just doing a single click does not. Visual 
voice mail view also indicates if the message is urgent or confidential. 

Starting with Release 22.9.2, refreshing the voice mail view is also done when opening the 
voice mail view. This is in addition to the currently supported usage of the voice mail 
refresh at login and 24 hours after the last usage of the API if you are still logged in. 

Missed calls are indicated by an icon in the Main window. Missed video and audio calls 
are indicated with a different icon. Note that the MWI icon is in the same place when it 
indicates a new voice mail. 

Visual voice mail is also supported when enabled by your service provider. You can see 
all voice mails in a list and play them inside the Main window. 

The following settings are needed on CommPilot portal to have visual voice mail: 

 Voice messaging enabled

 “When message arrives, use unified messaging” option enabled

 “Use Phone Message Waiting Indicator” option

enabled Auto-deleted voice mails are cleaned once

a day.

The voicemail counts in voice portal and Mobility are slightly different. Voice portal 
messages can be either “New” or “Saved” whereas Mobility messages are either “New” 
or “Viewed”. “Saved” in voice portal is the same state as “Viewed” in Mobility. When a 
message is clicked in Mobility, it is automatically set to “Viewed” status, which is different 
in the voice portal where messages can be skipped via DTMF (Starcode) to keep them 
in the “New” status. 

Call Pull 
Call Pull allows you to pull an ongoing call from one of your devices to another one where 
the Call Pull feature is used (native Desktop only). Call Pull can also be used with FACs, 
in this case, *11. User interface support has been added to the Desktop so that an end 
user does not have to remember FACs. Release 22.2.0 added support for the Call Pull 
button for Xsi calls as well. 
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Moderator Controls 
You can control the functionality available to participants if you are the owner of the 
session in My Room. You can do the following: 

 Dismiss one or more participants. This ends all sessions (group chat, audio, 
video, and share) when the participant is using Mobility for Desktop.

 Mute one or more participants.

 Lock or unlock the room (when locked, no additional participants can join).

 See active talker indication (room owner only).

 See full audio participant list.

 Choose who can join without separate authorization (moderated My Room):

− Require only guests to request access

− Require everyone to request access

− Allow everyone to join automatically

To invoke the features, you can use the right-click menus, or you can click on the 
moderator control icons of a participant. Note that most features are not available via 
icons. To dismiss or mute all participants or lock the room, use the right-click menus 
available for your own icon at the top of the participant list. 

If you are not the owner, you can only see the XMPP (chat) participant list or the full 
participant list along with mobile participants (depending on your service provider settings). 

Forced Logout 
Depending on your service provider settings, you may see a pop-up saying that you have 
been logged out due to another instance of the client logging in (native Desktop only). 
This feature allows BroadWorks to track similar online client instances and only allow one 
of them to be online at the same time. When BroadWorks notifies the client to log out, all 
connections are terminated, and client returns to the login window. 

Echo (Test) Service 
Use this Main window menu option to make a test call to verify voice and video quality. 
The echo service asks you to record a message and plays that message back 
immediately before hanging up. The echo service may be available in different languages 
depending on your service provider settings. 

Headset Support 
You can control incoming and ongoing calls from a compatible headset. The feature set 
supported is answer/hang up as well as mute/unmute. Volume control operations are not 
reflected in the Mobility UI. The following is a list of tested example devices, although 
other devices should also work: 

 Plantronics Voyager Edge UC

 Plantronics Savi 700 series

 Plantronics Blackwire C3xx, C4xx, C5xx, and C7xx

MOBILITY DESKTOP USER GUIDE

25



 Plantronics Calisto 620

 Plantronics Voyager Legend UC

 Logitech H570e Mono

 Logitech BCC950

 Logitech Conference Cam Connect

 Jabra Biz 2300/2400

 Jabra Speak 510

 Jabra Pro 930 (wireless)

 Sennheiser SC 230/260

 Sennheiser SP 20

 Sennheiser MB Pro1 UC

For a complete list of tested devices, see the Partner Equipment Interoperability Summary 
available on Xchange: 

https://xchange.broadsoft.com/node/464941 

Headsets typically use an add-in of some kind to communicate with the rest of the client 
while calls are made. Currently, installed add-ins are visible from the Preferences Add-ins 
tab. 

In addition to the standard HID Add-in developed by Cisco (formerly BroadSoft), headset 
vendors can develop their own add-ins that can replace the Cisco (formerly BroadSoft) 
Standard HID Add-in for all devices. Some of these add-ins (for example, Jabra or 
Sennheiser) cannot be used at the same time with the standard HID Add-in so either the 
Cisco (formerly BroadSoft) Standard HID Add-in or the vendor-specific add-in must be 
disabled via Options in the Mobility client if one of the two is not automatically disconnected. 
Add-in installers should copy the required add-in dlls into the add-in folder, so they become 
visible in Options. 

These vendor-specific add-ins are typically installed during new headset installation; 
however, the Cisco (formerly BroadSoft) Standard HID Add-in should remain in the 
preferences list. If for some reason it has disappeared, adding the respective .dll file back 
to the add-in folder should make it visible again in the Preferences. If later on you want to 
change to another headset, the vendor-specific add-in could be disabled from Preferences 
to again use the standard HID or some other new add-in by another headset provider. 
 

Re-login is necessary to take the new add-in into use. 

Some USB headsets may have additional functionality offered by the vendor-specific add- 
in such as answering the call directly when taking the USB headset off dock. See the 
USB headset documentation for details of such functionality. 

If you are using many different headsets, the Cisco (formerly BroadSoft) Standard HID 
Add-in offers a default add-in that can always be used. 

The following is the default add-in folder location (note that it is not possible to write to this 
location in all systems): 

 Windows 7/Windows 8/8.1/10: C:\Program Files (x86)\BroadSoft\UC-One\connectors

Uninstallation does not remove add-in DLLs. In general, the following steps could be 
followed with third-party add-in DLLs. 
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1) Make sure that both UC-One and the third-party add-in are installed.

2) Go to UC-One → Preferences → Extensions.

3) Enable your add-in of choice, either USB Device Add-in by Cisco (formerly
BroadSoft) or a USB headset vendor-specific one.

4) Restart UC-One to take the changes into use.

If you want to use several devices, consider the following rules for audio device auto- 
selection: 

1) Mobility has a list of five last selected audio devices per each audio device selection
control in Mobility Options. Each audio device can exist in a list once at most, that
is, if a device becomes selected again before four other devices have been
selected, a duplicate item will not be created for the device in the list, but the existing
item will be moved to the beginning of the list. The order of items in the list is
significant in the sense that it defines the order in which other devices become
selected when a device is disconnected. In a laptop for instance, the native
microphone and speaker are one applicable device for the list of five devices. A
device can only end up to the list of five devices above during disconnection.

2) The “Use default” item is never put on the list as it will serve as a fallback if none of
the five devices on the list are available. The end user has a chance to specify the
default device and the default communications device.

3) When a device is reconnected, it becomes automatically selected only if it was
selected when it was disconnected. Disconnecting devices that are currently not
selected does not have any special behavior. Information on devices disconnected
while selected is not persisted in the database, that is, this
behavior does not work over different user sessions.
In a case with two devices involved (for example, a headset and the native
speaker/microphone) and end users sometimes selects both, the ability to
automatically fluctuate between built-in devices and third-party headset when
plugging it in should be obtainable by using the OS default device selection for the
in-built devices and then plugging in the headset.

Team Telephony 
Team Telephony is comprised of a Team Telephony window showing the predefined 
team members and their related call states (native Desktop only). For a ringing call, the 
only action is to pick it up. 

Each Team Telephony member can have four call states: available, busy in call, ringing, 
and offline. The status for a Team Telephony member is shown in the Team Telephony 
window. When a line is ringing, you can see the caller ID in the respective lines tooltip if 
configured by your service provider. All team members can see the full list of team 
members in the Team Telephony window. A double-click on the team member performs 
the default action towards the contact. You can drag and drop people from the contact list 
to the Team Telephony window or vice versa to transfer or conference calls. 

The corresponding server-side service must be provisioned and assigned by the service 
provider for the client to work. Usual call management options are available once the call 
has been answered. 
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Presence Rules and Silent Alerting 
Starting with Release 21.2.0, you can combine call processing with presence statuses 
(native Desktop only). For instance, the “Busy” status can be combined with Call 
Forwarding so that when the “Busy” presence status is used, calls are forwarded. It does 
not matter how the presence status is invoked, via automation or manually. 

All presence statuses can have presence rules: 

 Available

 Busy

 Away

 Offline

The following BroadWorks call processing services can be used:

 Silent alerting

 Call forwarding to number

 No rules

If presence rules are used, all your client devices should have this service enabled to 
avoid side effects. Silent Alerting is supported whenever an incoming call has that feature 
enabled. Silent alerting can only be enabled via presence rules in Mobility, but various 
settings can also be altered via web provisioning. 

Call Center Agent Login 
Starting with Release 21.2.0, you can also log in to your call center queues if you are a call 
center agent (native Desktop only). You can do the following: 

 View your call queues.

 Join your call queues.

 Set the Automatic Call Distribution (ACD) status so that you get incoming call
center calls. However, this is dependent on your license settings.

With suitable ACD status such as “Available”, incoming calls to the queue are routed to 
your client. With “Unavailable” ACD status, the BroadWorks Do Not Disturb (DND) state 
can also be selected or “Personal Call”. Each ACD status indicates with text if you are to 
receive incoming call center calls. 

Dynamic ACD status updates are not supported if the ACD status is changed somewhere 
else. 

Remote Control Event Package 
Remote Control allows you to answer a call, put it on hold from a receptionist, or call 
center client while the results are seen in your Mobility Desktop client. Answer and 
hold/resume buttons are visible in Receptionist/thin client to perform call management 
operations. 

This feature must be enabled by your service provider for it to be used. 
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Auto-Answer 
Release 21.5.0 introduced support for auto-answering incoming SIP calls for call center 
scenarios. The incoming call notification is identical to the usual incoming call notification. 

Web Pop 
Starting with Desktop Release 21.6.0, Service Providers may enable Web Pop. This 
allows users to get more information about an incoming call by clicking on the web pop 
button of the incoming call toaster. You can also do the same for outgoing calls using 
menus. 

This opens your default web browser with a predefined URL that provides more 
information about the other party. 

You can also change this URL in Preferences, if allowed by the service provider. 

This feature is not available for Team Telephony calls. 

Hide Communications Window Notifications and Tones 
Depending on your service provider settings, Mobility notifications and tones in 
the Communications window can be hidden. 

Application or Desktop Share 

To share your desktop or individual application: 

1) In the Communications tab, click the Start Share button. This does not yet start the
“share”.

2) Select either to share your entire display or one of your open applications and click
Start Sharing.

The share widget appears to let you control share settings such as Preview that shows
you what participants are seeing and Pause that pauses sharing.

3) To stop sharing, click the Stop icon. While sharing, all other communications
mechanisms are also available except for video calling and file transfer. Participants
cannot hide a share without closing the Communications window. Video call is also
available while sharing.

Desktop sharing works the same way in both My Room and in ad hoc sessions. For
participants without Mobility, use the separate Desktop Share Invitation link, if available,
by right-clicking the My Room button. Share selector is not dynamically updated while
the selector is open and minimized applications are not available in the list of
applications to share.

As a participant, you can also zoom in and out during the share. As the share owner,
incoming message toasters are suppressed during share, but the missed message
badge is incremented, and the incoming message sound is played when enabled.

If you are first in a video call and then start share, your own video is not shown due to
limited space available, but you can make it visible using the Main window menu in
the bottom right-hand corner by selecting “Show Own Video”.

If you are using dual monitors, you can choose which monitor to share. You can check
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the primary monitor in the operating system settings. 

You can also remove desktop share participants. They are also removed from the group 
chat at the same time. If needed, the removed participants can join later. 

Depending on your service provider settings, you may have to provide desktop share 
credentials manually. 

In addition, participants can share when enabled by the service provider by clicking on 
the Share button; however, the room owner can prevent this at any time. Only one 
person can share at any one time in a session. Only one share at a time is supported if 
you have sessions with many users at the same time. Share passing is only supported 
in My Room. 

Participants do not have to take any action to accept the share invitation. It is 
automatically accepted. The same also applies to share passing. That is, the owner 
does not have to take any action for the participant to start sharing. 

When video and share are used at the same time, the different views cannot be 
resized. Instead, the primary view can be selected from the bottom of the window via 
thumbnails. 

In deployments using the older web collaboration solution, clicking the Share button 
opens an external browser window where share can be viewed. 

My Room 

My Room is started by clicking on the My Room icon on the top right-hand side of the Main 
window. My Room is started automatically using your permanent chat room. Add more 
participants by dragging and dropping them into the Communications tab or the Conference menu. 
Otherwise, they can join your room by right-clicking your name on their contact list and choosing 
the Join Room menu option. Once people have joined the chat room, they can click on the Call 
button of that window to join the conference. The room owner can also share their desktop. 

To use the full functionality of My Room (desktop sharing, conferencing, and chat combined), you 
may have to manually enter your desktop sharing credentials, your conferencing number, and 
your PIN in the Preferences → Credentials window. This depends on your service provider 
settings. 

In addition to the owner of the room, participants can also share the desktop but only the owner 
can add more participants. This applies to both My Room and ad hoc sessions. 

1) To see a Context menu, right-click the Options icon (three dots) on the right-hand side
of the My Room tab for Room Info.

2) To modify credentials and conference bridge information, select Configure to go to the
preferences. If your service provider has automatic provisioning enabled, then this menu
item is not present.

3) Select Copy Guest Link to copy an invitation link to the operating system clipboard
(depending on your service provider setup, this menu option may not be available). Paste
this link, for instance, to a meeting invitation email to allow Mobility participants to join the
conference in one click from, for example, Outlook, or Office applications. Note that some
applications may not recognize the Mobility (btbc:) link. You can also copy the My Room
Invitation to the default email client (this text does not contain the Mobility link) and go to
the My Room preferences via a right-click menu option.
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The link has two parts: one for Mobility users and another one for users with some other 
client. Depending on your service provider settings, the invitation can also contain a link to 
the desktop sharing session. The invitation always contains a dial-in number and PIN for 
users who do not have Mobility. The desktop share link, when available, allows anyone to 
join a desktop share session from a standard web browser. In addition, the Mobility group 
chat session is supported with the web collaboration session. For guest user links, see the 
next section. 

The My Room info area indicates the conference bridge details of your My Room. You 
can also export the attendee list using the related participant menu available via the 
options icon (three dots). 

The Communications window also has an icon that provides the same Context menu 
previously discussed. 

For more information on desktop sharing, see section Application or Desktop Share. 
Desktop sharing works the same way for both My Room and the ad hoc sessions. 

My Room uses your permanent chat room, permanent collaboration room, and 
conference bridge (audio or video). My Room is the only way to use the permanent 
rooms. Any other multiparty communications, such as selecting multiple contacts, and 
right-clicking for a conference call, or dragging and dropping for a one-to-one chat, is done 
using ad hoc rooms. Ad hoc rooms are deleted once the session is over. 

All My Room sessions start as chats but call and/or share can be added to the session 
while in progress. File transfer and video conferencing are not supported in My Room or 
ad hoc sessions, additionally, you cannot transfer or conference My Room calls. 

You can also define that all users or only guest users need to be authorized to access My 
Room or that all users can automatically join. My Room invitations sent by you cannot be 
canceled in this release. 

My Room calls cannot be conferenced or transferred. 

In the Preferences → General tab, you can select to use an external Webex Meetings app 
for your My Room sessions. In that case, there is no synchronization of events between 
Mobility and Webex Meetings. 

Guest Client 
Previously it was not possible to join a full My Room session with a web browser. Guest 
client allows you to do that. 

This feature is especially intended for users outside of the company. Generate separate 
invitations for guest users using My Room right-click menu items as described in the 
previous section. My Room invitations are generated using separate menu items and are 
intended for Mobility users. 

Guest users can join a session with audio in the web browser by requesting a callback 
using the provided dial-in number and conference PIN as well as use group chat and 
sharing inside the web browser. However, guest clients do not have private chat 
possibility and they can see the chat history of messages that occurred after they joined 
the session. 

The invitations persist until reset via a separate right-click menu item. Individually accept 
each joining guest participant. Not doing this in a predefined period of time results in the 
invitation becoming obsolete and guests not being able to use the link to join. For more 
information, see section Moderator Controls. 
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After dismissing a guest user from share and chat, the audio/video portion can remain. 

The following OS and browser combinations are supported if Web Real-Time 
Communication (WebRTC) is disabled by your service provider: 

 Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and
Windows 8.1 [Classic]) and Mac OS (10.8 and 10.9)

 Internet Explorer 11 on Windows (Windows 7, Windows 8 [Classic], and
Windows 8.1 [Classic])

 Safari 7 on Mac OS (10.8 and 10.9.)

The following OS and browser combinations are supported if WebRTC is enabled 
by your service provider: 

 Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and
Windows 8.1 [Classic]) and Mac OS (10.8, 10.9, and 10.10)

For more information on guest client usage, see Appendix B: Guest Client Usage. 
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Universal Search 

Mobility supports a universal search of the enterprise directory, personal directory, enterprise 
common directory, and group common directory as well as chat messages and calls. This takes 
place in the same Search field that is used for both a local and presence- enabled contact list 
search, the results are separated onto their own tabs: 

 Chat messages

 Contacts

 Calls

The various directories have different purposes with the enterprise directory having the most data, 
and not all directories may be used in all deployments. All search results are combined into one 
common set of results. 

Personal directory, enterprise common, and group common directories cannot be modified from 
the client side. Only read access is provided. A snapshot of the presence status of the contact in 
the results list is shown, but this presence is not updated after the search operation. 

Personal directory provides your own special contacts that are not in the enterprise directory, for 
instance, partner company’s numbers while group common contains, for example, the group’s 
contacts such as favorite pizza taxi. 

Mobility automatically searches the local contacts and presence-enabled contact list in addition to 
the enterprise and other directories at the same time. As soon as there are results from the 
enterprise and other directories, these results are shown on a separate list in the Main window. 
Additionally, there may be other search result groups from other search sources such as LDAP or 
Outlook (native Desktop only). 

In a search, Mobility also supports Hiragana characters for the Japanese market. 

Search results are displayed differently depending on the results of the contact list and directory 
search: 

 If LDAP search (Corporate directory) or Outlook search are enabled, there are more
result groups.

 If there are no results for a certain search source (for example, local contacts, Outlook,
LDAP, or BroadWorks Telephony Directory), then that group is different in the UI.

The enterprise directory searches all available fields for the search string. By default, it
waits for 1.5 seconds before it sends the search request to the server to minimize
unnecessary load on the server.

Release 21.5.0 introduced support for showing phone number in the search results to
better distinguish similar search results. In addition, ToolTips are provided for search
results.

Release 22.4.0 added support for department and title in directory search results as well
as multi-part search string enhancements depending on service provider configuration on
the server side. The server will apply the AND operation for each search string part, and
the order in which the individual parts are provided will not impact the search result. The
enhancement applies all Xsi directories (enterprise directory, personal directory, group
common, and enterprise common). For example:

 While looking for Philip Moorefield, the following search string can be used: “Phil
Moore”. An exact match of the first name is no longer required.
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 Looking for Joe Gold and using “jo go” or “go jo” as a search string provides the same
results.

 If Gregory Evermoore has for instance an email address
“gevermoore@company.com”, he can be found using “ge” as a search string.

Typically, when adding a contact using directory search results, there are phone numbers
and first names in addition to last names available. In addition, the Extensible Messaging
and Presence Protocol (XMPP) address and other fields are imported when found to allow
presence and chat.

Release 22.7.0 added support for configurability of search results for virtual subscribers
such as call centers. Depending on your service provider settings, the search results may
look different in what kind of display name is shown for virtual subscribers.

LDAP search (Corporate directory) must be enabled by your service provider. In addition,
depending on your service provider settings, you may have to manually provide your
LDAP credentials in the Preferences → Security tab. LDAP search results are provided in
the corporate directory group in the search results.

Outlook integration (search and calendar integration) on Windows requires one of the
following versions installed on the desktop:

 Outlook 2013

 Outlook 2016

 Outlook 2019

 Outlook 365

Outlook search also works when several Outlook accounts are in use, but only one 
account is used at a time (default selected, which can be changed in Outlook). 
Additionally, other related considerations are as follows: 

 The client searches for contacts and calendar entries in the default Outlook
account. The account is set to the default via File → Info (left pane) → Account
Settings → Account Settings → Data Files. Select an account and mark it as
“Set as Default”. After making this change, sign out and sign back in to the client
and it now searches that account for contacts and calendar entries.

 The client searches the Outlook contacts only on the local machine (that is, the
Outlook Address Book). There is no Exchange server lookup performed. In
addition, all directories in Outlook are searched for contacts, even deleted folders.
The Contacts directory can also have multiple levels of subfolders.

Every minute, Mobility reads Outlook appointments. If there is an appointment
running at the current time, then the presence is shown as Busy – In Meeting.
Overlapping appointments are also handled. Following are some examples of
Mobility operation with Outlook when time is 9:10 A.M.

 There is meeting “A” 9 A.M. through 10 A.M. Presence is shown as Busy –
In Meeting.

 Presence is explicitly changed to Available at 9:15 A.M. Presence is shown as
Available.

 In the next minute, Mobility again reads the appointments and sees that “A”
meeting is running; however, the presence was already explicitly marked as
Available and presence is not shown as Busy – In Meeting but Available.
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 There is an overlapping meeting “B” 9:30 A.M. through 10:30 A.M. Presence
is shown as Busy – In Meeting when the time is 9:30 A.M.

When deleting a meeting that is currently ongoing in Outlook, the presence status
remains as Busy – In Meeting until the next time Outlook appointments are
checked (once every minute) and after that, presence is shown as Available. This
change may be instantaneous, or it may take a minute depending on how close
the timer is to being triggered.

The Outlook Object Security model was introduced in Outlook 2007; however, it is
no longer supported in Mobility. It has been tested with Outlook 2010. For Outlook
versions prior to 2007, the Allow/Deny pop-up window seen in previous releases
should not be triggered. However, those versions are not officially supported. For
Outlook 2013, the behavior should be similar to 2010, meaning the pop-up should
not come up with Outlook 2010 and 2013 in Release 20.0.0 and onwards.

The presence update is only triggered by appointments and meetings that are
either accepted by the user or made by them. All day meetings do not trigger a
presence change to Busy – In Meeting.

Full Enterprise Directory 

Mobility allows for browsing of an entire BroadWorks enterprise directory. 

To view the BroadWorks enterprise directory, click the Directory button on the left-hand side of 
the navigation pane (if available). This feature depends on the service provider configuration so 
it may not be visible in all clients. 

Communications History 

The fourth icon from the top in the Main window on the left-hand side of the navigation pane 
displays your call history. History view is divided into one, two, or three tabs depending on your 
service provider settings. Possible tabs are: 

 Calls

 Visual voice mail

Clicking a visual voice mail downloads the message so you can play it.

Mobility saves a call history for placed, received, and missed calls. The call history makes
it easy for you to redial and call back when you have missed a call or you want to easily
dial a contact with whom you have recently spoken. Each call has a separate entry in the
list.

Chat history for group chats, both in My Room and in instant group chat, are stored locally
on the Desktop client, just like in one-to-one chat, but only for the time the user is joined
into the session. Look at individual chats by double-clicking the contact in the contact list or
click the chat history icon in the left pane.

Double-click on a name in the list to call back directly (this calls back the same way you
previously spoke, for example, if you were in a video call, double-clicking starts a new
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video call). Double-clicking an incoming call item in the Calls tab makes a call. 

To clear the missed chat indicator, you must open the missed chat. 

The Call History missed communications badges can be cleared by using the right-click 
menu from the Call History button on the left pane (native Desktop only). The menu 
provides options to mark “All as viewed”, “Voicemails as viewed”, and “Calls as viewed”. 

Depending on your service provider configuration, call history may also display call 
duration as well as hunt group or other Call Forwarding information. 

Release 22.5.0 added support for synchronizing the history items with configured 
directories so that the display name shown is be as accurate as possible. 

Click-to-Call (Highlight Text) 

Release 21.5.0 introduced support for Click-to-Call using highlighted text and global keyboard 
shortcuts. Users can highlight text anywhere in the desktop machine to make a call and define 
the default call type used for making the call using the shortcut defined in Preferences. On Mac 
OS, you must define the shortcuts on your own using the instructions provided in Preferences. 
The order in which key combinations are pressed may be significant in some cases if the 
operating system has reserved some key combinations for other purposes. 

Callto, Tel URL, and Other URL Schemes 

You can use Mobility for making calls using Callto, and Tel URL links anywhere in your machine, 
but you need to register Mobility as the primary application for that purpose in the operating 
system. Additionally, depending on your service provider settings, other URL schemes may also 
work. 

On Windows, at first login there is a dialog asking if you would like Mobility to be the primary 
calling application for Callto and Tel URL schemes. Answering yes will modify Windows settings 
so that the next call using those links will use Mobility. If another application should afterwards 
take precedence in Windows settings, you can again make Mobility the primary calling application 
from Preferences, Outgoing Calls tab. 

On Mac OS, you must make the same selection in FaceTime preferences. You are required to 
log in to FaceTime to change the preferred calling application. 

XMPP Security 

Depending on your service provider configuration, Mobility supports blocking of unauthorized file 
types in file transfer in order to support service provider IT policies (native Desktop only). When 
sending a file with of an unauthorized type, there is an error message showing the cause of the file 
transfer failure. 

Similarly, clickable links in chat may be disabled; however, you can still copy the link into a 
browser. 
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Privacy Policy 

If you want to read the service provider privacy policy that can be done by clicking the privacy policy 
link available in the About view when enabled by your service provider. If you service provider has 
not enabled the link, it will not be present in the About view. 

IPv6 Support 

Release 22.5.0 added support for IPv6. IPv6 usage depends on your service provider. 

Options/Preferences

Options provide access to available preferences and settings for Mobility. 
Follow these steps to access these settings: 

Windows and Mac OS 
1) Click the Options icon in the Main window left pane.

2) Select the desired view from the drop-down. Or

Windows and Mac OS 
1) Go to the Mobility accessibility menu.

2) Select Preferences.

3) Select the desired view from the   drop-down menu.

General 

Language 
Select your language then click OK or Apply and the change takes effect immediately. 
Note that the number of languages depends on your service provider. 

Login 
Enable or disable automatic login when starting the application and control the remember 
password feature as well as enable the Update Password feature. 

Notifications 
Usually there is a confirmation pop-up notification each time you remove a contact or 
chat history record. By selecting one or all of the check boxes, you can disable the 
confirmations when deleting information. You can also control whether there is always a 
pop-up notification for publishing location information. Typically, this is shown at login. 
You can also select whether to receive a notification before ending communication or 
holding a call. 
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Appearance
Enable single-click mode allows users to launch chats without tabs with a 
single click, and offers additional usability improvements and optimizations.

Accessibility 
Enable pop-up errors allows Mobility error pop-ups to be shown in addition to the 
usual error text shown at the top of the Main window. 

Enable ToolTips is enabled by default. For accessibility, screen reader/VoiceOver 
reads all ToolTips, which may be frequent and hence disturbing. For this reason, 
in accessibility cases, it is recommended to disable ToolTips. 

You can also enable spell checking and auto-capitalization. 

Audio/Video 

Audio 

Headset 
Here you can specify what are the output and input devices used for the headset 
when toggling between the headset and speakers. Note that to be able to toggle 
between the headset and speakers during calls, you must specify a different 
device for each. Using the default for both results in the same device being 
assigned to both so toggling does not work. 

Output Device (Voice Playback) 
Choose a headset, PC-integrated speakers, or external speakers for audio output. 
Your external playback device is selected by default (if you have one connected). 

Input Device (Voice Recording) 
Choose a headset microphone, PC-integrated microphone, or external 
microphone for voice during calls. Your external recording device is selected by 
default (if you have one connected). You can also choose automatic gain control 
and test your recording device. 

Speakers 
Here you can specify what are the output and input devices used for speakers 
when toggling between the headset and speakers. 

Note that to be able to toggle between the headset and speakers during calls, you 
must specify a different device for each. Using the default for both results in the 
same device being assigned to both so toggling does not work. 

Output Device (Voice Playback) 
Choose a headset, PC-integrated speakers, or external speakers for audio output. 
Your external playback device is selected by default (if you have one connected). 

Input Device (Voice Recording) 
Choose a headset microphone, PC-integrated microphone, or external 
microphone for voice during calls. Your external recording device is selected by 
default (if you have one connected). You can also choose automatic gain control 
and test your recording device. 
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Ring Device (Alert Signal) 
Select the audio device that is played when you receive an incoming call. 

Ring Signal 
You can select your own ring signal. The same signal is used for both voice and 
video calls. If the Alert Info service is used, the network may instruct a certain 
ringing tone to be played. 

You can also select an icon to play a tone for incoming messages. To disable 
the tone, uncheck the icon. Select a sound event and then click Play to hear the 
sound. If Alert Info service is used, the network may instruct a certain ringing 
tone to be played. 

Video 

Capture Device (Video) 
Select a camera that you want to use for video calls. Your external web cam is 
selected by default (if you have one connected). 

Video Size 
Select one of the available sizes. Note, however, that higher sizes 
require more bandwidth and a more capable central processing unit 
(CPU). 

Click Test Call to make a test call to test voice quality. 

Incoming Calls 
For the list of available call management services for incoming calls, see section 
Call Settings. If Alert Info service is used, the network may instruct a certain ringing 
tone to be played. 

Outgoing Calls 
For the list of available call management services for outgoing calls, see section 
Call Settings. Release 22.7.0 introduced support for the Review feature that you can 
enable in Preferences → Outgoing calls. Review brings you to the dial pad with the called 
number pre-populated so that you can modify or review it when you are using the default 
call type by for instance making a call from a web browser using Mobility. In addition, 
highlight to call and Register to call settings are available in Outgoing calls. 

Voice Mail 
You can specify various voice mail settings, such as which calls are sent to voice mail, 
what kinds of notifications you receive when voice mail arrives as well as controlling how 
fast the voice mail greeting is played and if callers are allowed to leave voice mails. In 
addition, you can control how callers can end up going to voice mail. 

Services 
In this release, this section is reserved for presence rules and Hub settings. For more 
information on presence rules, see section Presence Rules and Silent Alerting. 
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Integrations 
Select how incoming add-in requests are handled, whether they are automatically 
accepted or not or if incoming requests are allowed at all. 

Depending on your service provider configuration, you can also manage extensions 
using the Mobility Application Programming Interface (API), which is used by third-party 
applications such as the Outlook Add-in or compatible headsets. You can allow such 
third-party applications to obtain information from Mobility and enable or disable 
confirmation pop-up notifications when third-party applications request information from 
Mobility. You can also choose default behavior to always reject or accept requests from 
third-party applications and allow or reject individual third-party applications. 

Starting with Release 22.0.0, the following logic applies for accepting application requests: 

 Every new first-party application is allowed to connect without user interaction.

 Every new third-party application opens a dialog asking for permission to connect.
Your response is remembered (both negative and positive responses).

Advanced 

The Advanced view contains three different subsections: 
 Troubleshooting

 Proxy

 Credentials

Troubleshooting 
Logging is used for troubleshooting. You may be asked by your service provider to 
turn on logging and then send the log file directory contents. You can choose basic logging 
or more detailed logging to be enabled. Detailed logging may consume memory resources, 
so it is not recommended to have it enabled for a long period of time. 

You can also clear the logs and open the logging folder as well as enable and disable 
Google Analytics. 

Proxy 
Select how to handle HTTP proxies. By default, the system settings are used but you can 
also choose not to use an HTTP proxy or to use the Mobility (client) proxy settings. 

Credentials 
Credentials section in the Preferences may be empty depending on your service 
provider configuration. If the Login window has an embedded configuration URL 
(see below), the credentials or the configuration URL are not visible. 

Configuration URL 
If the Device Management configuration URL is available to be viewed, it appears here. 
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IM Address 
If XMPP credentials are available to be viewed, they appear here. 

BroadWorks ID 
This is the user name that you use to log in. 

Call Settings 

Mobility supports the following service management features allowing supplementary services 
to be managed using the Preferences and Incoming Calls and Outgoing Calls view available in 
the Main window left pane by selecting the appropriate sub-view in the drop-down: 

 Incoming calls

− BroadWorks Anywhere

− BroadWorks Remote Office

− Forward Calls

− Do Not Disturb

− Simultaneous Ring Personal

− Anonymous Call Rejection

− Call Waiting

 Voice Messaging

 Outgoing Calls

− Block My Number (Calling Line Identification Presentation [CLIP]/Calling Line
Identification Restriction [CLIR])

− Automatic Callback

− Highlight to call

− Register to call

You can also use the Call Settings with a Main window toolbar on the top of the window, if this 
feature is enabled. When enabled, this feature allows BroadWorks Anywhere, Do Not Disturb, 
Remote Office, and Call Forwarding to be managed in the Main window using single clicks or 
right clicks. From Release 20.2 onwards, the Call Settings toolbar is an icon in the left pane with 
right-click menus. 
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BroadWorks Anywhere 
BroadWorks Anywhere allows service providers to offer fixed-mobile convergence (FMC) 
services today without additional equipment. 

BroadWorks Anywhere simplifies communications for on-the-go users and remote users 
by extending the features of a desk phone to any other fixed or mobile device, regardless 
of the network or handset manufacturer. Callers dial one number and can reach you on 
any phone the user chooses. A desk phone, cell phone, and/or a soft phone may ring 
simultaneously. 

Experience voice call continuity with the ability to move live calls from one device to 
another without hanging up. 

Add locations (numbers) that can be used in the service via the Add Number field. Use 
the Alert all locations simultaneously check box to activate parallel ringing. Click on the 
“+” icon to see more options. 

The Don’t divert check box prevents a call from ending up as a voice mail, which can be 
problematic in, for example, conference call situations. 

Select Answer Confirmation to receive a separate audio prompt when answering a call 
from that number (location). It may be useful in cases where, for example, mobile 
numbers are being used to prevent incoming calls going to mobile voice mail since the call 
will be ended without going to voice mail if the answer confirmation is not provided. 

Select the Call Control check box to enable the server platform to provide mid-call services 
such as Call Transfer and Conferencing for that number (location). 

BroadWorks Remote Office 
This service allows the use of any phone as the office phone from a charging and 
numbering perspective. For instance, a hotel room phone can be used as the office 
phone. 

Enable Remote Office by clicking the service icon and specifying a phone number to be 
used as the Remote Office number. 

Forward Calls 
Enter a number to which your calls should be forwarded. Different variants of Call 
Forwarding are supported, such as forwarding always, forwarding when busy, and 
forwarding when you cannot answer or when you are unreachable. In addition, you 
can specify the number of rings before Call Forwarding is triggered. 

Do Not Disturb 
When you activate this service, all calls are typically blocked by the server and are sent to 
voice mail. Enable this service by enabling the service icon. 

Hide Number 
You can hide or display your number when calling or communicating with other parties or 
contacts. Hide your number by enabling the service icon. To show your number, set this 
to “Disable”. 
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Simultaneous Ring Personal 
Add up to ten additional numbers or Session Initiation Protocol Uniform Resource 
Identifier (SIP URI) addresses that you would like to ring in addition to your primary 
number when you receive a call. In addition, specify whether you want answer 
confirmations and if you would like to receive calls when already on another call. This 
service is an older variant of BroadWorks Anywhere. 

Voice Messaging 
You can enable or disable voice messaging in the Preferences and Incoming Calls tab. A 
number of settings are available: 

 Send all calls to voice mail.

 Send busy calls to voice mail.

 Send unanswered calls to voice mail.

 Specify how voice mail messages are handled using an indicator in Mobility or
forwarding to email.

 Enable notifications of new messages via email.

 Email a carbon copy of new voice mail.

 Transfer incoming calls to a specified number using “0” DTMF.

 Specify how many rings are used before sending an incoming call to voice mail.

 Allow/disallow callers to leave a message.

Anonymous Call Rejection 
The Anonymous Call Rejection service allows you to reject calls from parties who have 
explicitly restricted their identities. 

You can enable or disable Anonymous Call Rejection in the Preferences and Incoming 
Calls tab. 

Automatic Callback 
The Automatic Callback (ACB) service allows you to be notified when the previously called 
busy party becomes idle and is connected without having to redial the phone number. 

When you call another party and the call cannot be connected because the line is busy, 
you are prompted to make an Automatic Callback request (for example, “The line you are 
calling is busy. Press 1 if you would like to be notified when the line becomes available”). 

If you select Automatic Callback, the system monitors the busy party and automatically 
establishes a call when the busy party becomes available. 

You can enable or disable Automatic Callback in the Preferences and Incoming Calls tab. 
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Call Waiting 
The Call Waiting service allows you to answer a call while already engaged in another call. 

You can enable or disable server-based Call Waiting in the Preferences and Outgoing 
Calls tab. If you disable Call Waiting, the second incoming call is not connected, and the 
caller hears an announcement that the call cannot be completed. Before you answer the 
first incoming call, the second incoming call will be rejected. 

Sign Out 

Signing out of Mobility sets your status to “Offline” for your contacts and displays the Sign In 
screen. 

Sign Out of Mobility 
To sign out, follow these steps. 

Windows 
1) Click the Mobility logo in the Main window title bar.

2) Select Sign Out.

Mac OS 
1) Select Actions from the main menu.

2) Select Sign Out.

Exit Application 
To exit the application completely, follow these steps. 

Windows and Mac OS 
Close the Sign In window. 

Windows 
1) Select the Mobility logo in the Main window title bar.

2) Click Exit (a keyboard shortcut can also be used).

Mac OS 
1) Select Mobility from the main menu.

2) Select Quit Mobility (a keyboard shortcut can also be used).

NOTE: Closing the Main window (not the Sign In window) does not exit the application but 
rather minimizes the application to the system tray (Dock). This allows you to continue to 
receive calls and messages without having the Contact List window appearing on the desktop. 
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Multi-Device Support 

Mobility supports users with multiple devices, according to the XMPP specifications. This is 
comprised of several features: 

 Chat invitations sent to a user are received on all devices. Once a particular device has
been used to answer the chat invitation, subsequent incoming messages only go to that
device.

 One can retrieve one’s own presence notifications when another client updates the
user’s presence. The client stores this information and updates its own presence so that
it is the same as the higher priority status it received, (that is, when the received status
update is manual). If the received presence update is not manual, it does not react to the
received update; it only notes it.

 Accepting a sharing presence invitation in one client is also recognized by another
client, and both clients start receiving presence updates.

 Last sent and received messages are available on all devices when the optional
message history feature is in use. All devices should use that feature at the same time
to avoid duplicate messages. Your service provider can control how long messages
are stored on the server. Synchronization is triggered:
− At login
− When opening a new tab
− When presence changes from idle (Away) to any other state
− When changing presence from offline to any other state

 Missed chat badges are synchronized across all own devices when this preview
feature is enabled.

 A new presence subscription made in one client is recognized in another. If the contact
declines the “invitation”, there are presence notifications from the server to all of the user’s
clients indicating that the subscription was terminated, and this information is shown to the
user. If the client receives two presence authorization requests from two or more devices
for the same user, it only shows one request to the user.

 Removing a contact from the contact list in one device is recognized in another client and
the contact list is updated (that is, the contact is removed) in the other client as well.

If a user has many devices, each device has the same status when shown to the end
user. In addition, the contacts on the contact list always see the same status with updates
shown in the following priority order:

– Busy

– Online

– Away

– Offline

This means, for example, that if one client publishes a Busy status and another client 
publishes another status, contacts see the user as Busy. Compatible devices such as 
desk phones are able to show presence in the same way. 
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Mobility keeps track of its own presence status as well as the status of other devices and 
deducts the combined presence based on these.  

When the Mobility smart device application and Mobility Desktop are used together, the 
automated presence feature is recommended to be used to have presence shown fully in 
both clients as Connect does not use XMPP. 

When the Mobility smart device application and Mobility Desktop are used together, 
there are also some rules about location. Mobile applications have a concept of 
background and foreground mode to save device resources. When the Mobility app 
comes to the foreground, it updates its location (where enabled). 

The Desktop client does not have separate state for being on foreground; it only detects 
general usage of the device. The client can be on the background or foreground and 
based on idle detection it can drop to away. This requires that the computer is not used at 
all; moving the mouse/using keyboard triggers resuming to available again and it also 
resets the idle timer. Today, idle detection (or returning from idle) does not trigger location 
update on Desktop in this release. 

When both clients are set to automatic, the last one to publish location “wins”. As 
mentioned, Connect updates the location in automatic mode when coming to the 
foreground while Desktop does not have a similar concept. In addition, the last location 
update, initiated by you, manual or automatic, “wins”. 

Installation 

The installer supports a number of options on Windows (native Desktop only) as follows, only 
Msi installer is supported: 

 Run when system starts (can be changed later  in Options/Preferences).

 Install Outlook Add-in.

 Install S4B integration.

 Modify Windows registry to enable S4B dial pad.

 Install for all                      users.

 Create a desktop icon.

 Select destination folder for installation.

 Select the name of the software in the Program              menu.

 Launch the client after  installation.

Agreeing to the license agreement takes place the first time the application is started, as on Mac 
OS. Note that two clicks are required to accept the EULA due to legal reasons. 

When installer has been run on an end user’s behalf by an administrator, the “Run 
program when system starts” option cannot be changed by that end user. 

If you disable startup, for example, in the Task Manager's Startup list (on Windows 8 and 
10) or from msconfig.exe on Windows 7, the change is not reflected in Preferences. The check
box remains checked and grey even though the client is not actually started automatically when
the system starts.

Your service provider typically has selected an installer language for you. The default language is 
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the language of the operating system; if that cannot be found, English is used as the fallback. 

The Outlook Add-in installer is bundled together with the Mobility installer, if enabled by your 
service provider. 

History is specific to the application name. If upgrading to another Mobility version that has a 
different application name, the history present in the other version is not available. 

Starting with Release 22.3.0, both the Outlook Add-in and S4B integration can be used simultaneously. 

Starting with Release 22.9.2, only Msi installer is supported. 

Uninstallation 

The uninstallation procedure is different for Windows and Mac OS. 

Windows 
Uninstallation is performed by launching the Windows uninstaller via the Start menu or by 
using the Windows “Remove programs” view inside the Control Panel. Windows 
uninstallation does not require you to select any options. The language used for the 
Windows Start menu string “Uninstall” is taken from the language chosen when installing 
the client. This string cannot be changed after installation. 

All files are deleted at uninstallation, except for the following files: 

 Registry entries

 Account files are only deleted when explicitly allowed by the end user on Windows.

Note that as a result, some USB headset add-in files may also get deleted. For a 
workaround, see the Troubleshooting section. 

Mac OS 
Uninstalling is performed by simply dragging the application folder from the Applications 
directory to the trash can; however, account files are not deleted. If you want to remove 
account files, they must be manually deleted. These are the file locations for the account 
directories. The following locations apply for all account directories: 

For branded clients: 

/Users/<USERNAME>/Library/Application 
Support/<company_name>/<application_name> 

For the reference client: 

/Users/<USERNAME>/Library/Application Support/BroadSoft/Communicator 
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Version Control and Automatic Upgrade 

Depending on your service provider settings, you may receive a notification to upgrade Mobility 
to a newer version. Starting with Release 22.3.0, this upgrade may take place automatically 
after you accept it in a separate dialog. In older versions, you must manually install the 
downloaded upgraded version. 

The upgrade may be recommended or mandatory. If it is mandatory, then Mobility does not start 
before the upgrade is done. 

In automatic upgrade dialog you can choose between: 

 Remind Me Later – You will get a new pop-up at next login.

 Skip This Version – You will not get a new pop-up for this version, but the next or if you
manually check for updates in the menu.

 Update Now – Upgrade is done immediately.

System Requirements 

System requirements are as follows on native Desktop: 

 Operating system: Mac OS 10.13 High Sierra, Mac OS 10.14 Mojave, Mac OS 10.15
Catalina, Windows 7 SP1, Windows 8/8.1, or Windows 10 (Classical view only).

 The installation footprint is approximately 125 megabytes (MB) on Mac OS and 215 MB
on Windows.

 For voice calls, a sound card, speakers, and a microphone or a headset are required.

 For video calls, a web cam is required.

Minimum system requirements for respective operating systems need to be fulfilled, with the 
following additions: 

 A minimum of 2 GB random access memory (RAM) is required.

 A minimum 1.5 GHz CPU is recommended. A dual core CPU is recommended for
video calls at a minimum.

For high definition (HD) video, the following is recommended: 

 HD camera

 HD resolution support in display

 Quad Core x86 or equivalent at a minimum

 4 GB RAM

VDI environments are not supported. 
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Troubleshooting 

Why are my Emojis showing as black boxes? 
The Segoe UI font is required for the Emojis to appear correctly. For more information on 
installing the Segoe UI font, see the following article: 

https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office-
applications-in-windows-7 

However, on Windows 7, some Emojis do not work despite this - as listed in the following 
table. 

Emoji Number Code 

1 x1f600 

5 x1f615 

7 x1f61B 

9 x1f62E 

11 x1f61F 

15 x1F611 

17 x1F913 

18 x1F634 

19 x1F644 

20 x1F922 

Why did I lose chat history after an upgrade to a renamed Mobility? 
When installing a Mobility version that has a different application name, the history is specific 
to that application name. If the application name remains the same in the upgrade, the 
previous history is available. 

Why can’t I chat with contacts from Yahoo? 
Chatting with users in other domains is possible but depends on the domain. For instance, 
BroadCloud supports Google federation but not Yahoo. However, group chat is not 
supported in Google federation, so the group chat option with those contacts is shown in 
grey. 

Why can’t I change the avatar? 
Double-clicking the avatar should open a File Explorer view to select a file. If your XMPP 
connection is lost, changing the avatar does not succeed. A lost XMPP connection is 
indicated in the Main window’s top notification area. 
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My contacts are all offline and my client’s status bar says “XMPP unavailable”. 
What does this mean? 
It means that the XMPP connectivity has been lost for chat, as well as for presence; 
however, you can still make calls. You should contact your service provider. 

Why am I offline? 
If you have selected “Offline” status, you are shown as offline to others. Another possibility 
is that you may have lost your Internet connection. In this case, the client does not log out, 
but rather enters an offline mode where a contact list is available, but communication is 
not possible. 

Why can’t I have more video resolutions available? 
You can choose your video resolution from Preferences and the Video tab. Your selection 
is used by default for future video calls. The available resolutions are automatically 
presented based on your camera. 

Why can’t I change my user name and password? 
User name and password editing is not supported in the client. To edit your user name or 
password, contact your service provider. The exception is login password expiry. When it 
expires, you can change the password in a separate dialog window. 

In Preferences, the client only supports changing credentials when enabled by the service 
provider. Desktop sharing credentials may also be changed, depending on your service 
provider settings. 

Why does my all day calendar entry not trigger Busy – In Meeting presence status? 
Not all meetings trigger a presence change to Busy – In Meeting. 

To trigger the presence update, the meeting must be in the Show me as busy state. 

Why aren’t all my group chat messages saved? 
Only the newest chat room messages are stored on the server, but never for My Room for 
security reasons. Starting from Release 21.3.0, when the optional (Preview mode in 
Release 21.3.0 and fully supported in Release 21.4.0) message history feature is enabled 
by your service provider, messages sent from other devices are also shown. 

Why aren’t all my chat messages available in my other devices? 
All one-on-one and group chat messages are saved, but only locally, so they are not 
necessarily available in your other devices. Incoming messages are sent to all devices; 
however, the ones that you send are only stored in the device that you are using to send 
the message. Starting from Release 21.3.0, when the optional (Preview mode in Release 
21.3.0) message history feature is enabled by your service provider, messages sent from 
other devices are also shown. 

Why can’t I change the XMPP address of a contact? 
This is not supported in this release. However, you can delete the contact and add a new 
one. 

Why does my location show an incorrect address? 
It is done based on the public IP address that the machine is using. The IP address is 
mapped to a physical location. Cisco (formerly BroadSoft) is working with the mapping 
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provider to improve the accuracy of the location. You can also manually change the 
location by clicking the avatar and changing the location icon. 

Why can’t I start desktop sharing? 
To share your desktop, you need to have valid credentials, either by manually entering 
desktop sharing credentials in the Preferences → Credentials window, or by using auto- 
provisioning to enable the desktop sharing menu items and icons. However, you can 
participate in desktop sharing sessions even without any sharing credentials. Your service 
provider settings dictate if auto-provisioning is enabled or not. 

I have a USB headset and the Call Control features are not working. Is there 
anything special I need to do to enable Call Control support? 
In order to use headsets on Windows (not supported on Mac OS), several steps are 
needed: 

1) When the client is started, you must accept the API connection request from the
connector/add-in device.

2) Additionally, your client must have the feature enabled by your service provider.

3) If your USB headset uses its own add-in, the standard HID Add-in from Cisco
(formerly BroadSoft) must be disabled, as both cannot be used a t the same
time. In addition, you must have “Allow 3rd party extensions” check box checked
in Options/Preferences → Extensions tab.

4) After upgrading Mobility, some USB headset add-ins may get deleted causing
call control to not work and the add-in to not be visible in Preferences. As a
workaround, repairing/re-installing the add-in software corrects this.
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Appendix A: Keyboard Shortcuts for Desktop 

The following table lists the currently supported keyboard shortcuts (native Desktop only). You 
can use these keyboard shortcuts to quickly perform frequently used actions. The characters 
used are lower case. The shortcuts are also indicated in the accessibility menus. 

Shortcut for Windows Shortcut for Mac What it does 

CTRL-Q Cmd-Q This quits the application. 

Alt+F4 Cmd-W This closes the selected 
window (except for a contact 
card and the About window). 

CTRL+C Cmd-C This copies selected text from 
Mobility to the clipboard. 

CTRL+V Cmd-V This pastes text from the 
clipboard to the location 
selected using the cursor in 
Mobility. 

CTRL-X Cmd-X This cuts the selected text to 
clipboard. 

Enter Enter When in the Communications 
window, this sends a chat 
message (if the Chat view is 
visible). 
When in the contact list, this 
opens a chat with the selected 
contact. 
When in the Communications 
History, this opens a 
communications session with 
the contact or address related 
to the selected item. This 
opens a chat if the item was 
chat and a call if the item was 
a call. 

-, Cmd-, This opens Preferences. 

F1 Cmd-? This opens Help. 

CTRL+A Cmd-A This selects all text in the Chat 
view. 

- Cmd-H This hides Mobility. 

- Alt-Cmd-H This hides other windows other 
than Mobility. 

CTRL-N Cmd-N This opens the Add Contact 
window. 

Shift-CTRL-N Shift-Cmd-N This opens the Add Group 
window. 

CTRL -1 Cmd-1 When a contact is selected, 
this opens a chat session with 
the contact. 

CTRL -2 Cmd-2 When a contact is selected, 
this calls the contact with 
audio. 
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Shortcut for Windows Shortcut for Mac What it does 

CTRL -3 Cmd-3 When a contact is selected, 
this calls the contact using call 
from phone. 

CTRL -4 Cmd-4 When a contact is selected, 
this calls the contact with 
video. 

CTRL -5 Cmd-5 When a contact is selected, 
this joins their room. 

CTRL -6 Cmd-6 When a contact is selected, 
this opens an email-sending 
window using the default email 
client. 

CTRL -I Cmd-I When a contact is selected, 
this opens the contact card for 
the contact. 

Shift-CTRL-F Shift-Cmd-F When a contact is selected, 
this makes the contact a 
favorite. 

CTRL-delete Cmd-delete This deletes the selected 
contact. 

CTRL-arrow down Cmd-arrow down This decreases the volume. 

CTRL-arrow up Cmd-arrow up This increases the volume. 

CTRL-space CTRL-space This mutes the client (while in 
a call). 

CTRL-D Cmd-D This turns on the Do Not 
Disturb service. 

CTRL-P Cmd-P This pulls an ongoing call from 
your other device to Mobility. 

Alt-shift- CTRL-P Alt-shift-Cmd-P This retrieves your parked call. 

- Alt-Cmd-2 This calls your voice mail with 
audio. 

- Alt-Cmd-3 This calls your voice mail with 
audio using call from phone. 

- Alt-Cmd-4 This calls your voice mail with 
video. 

Shift-CTRL-R Shift-Cmd-R This opens your My Room. 

CTRL-M Cmd-M This minimizes the window on 
Mac OS. On Windows, it only 
is used for the Team 
Telephony window. 

CTRL-T Cmd-T This enables always on top. 

- Shift-Cmd-M This opens the Main window. 

Shift-CTRL-C Shift-Cmd-C This opens contacts. 

Shift-CTRL-F2 Shift-Cmd-F2 This opens call history. 

Shift-CTRL-F1 Shift-Cmd-F1 This opens chat history. 
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Shortcut for Windows Shortcut for Mac What it does 

Shift-CTRL-F3 Shift-Cmd-F3 This opens visual voice mail. 

Shift-CTRL-D Shift-Cmd-D This opens the dial pad view. 

Shift-CTRL-W Shift-Cmd-W This opens the web button 
view. 

Shift-CTRL-O Cmd-O Causes Mobility to logout. 

Ctrl-7 Cmd-7 Answer incoming call with 
audio. 

Ctrl-8 Cmd-8 Answer incoming call with 
video. 

Ctrl-9 Cmd-9 Decline incoming call. 

MOBILITY DESKTOP USER GUIDE

54



Appendix B: Guest Client Usage 

This section provides more hands-on information about guest client usage. 

1) Right-click on the My Room icon to copy the guest join link and send it to a guest via
email or other means. You can also use the Copy Guest Link feature in My Room.

2) The guest can open the link in one of the supported browsers, enter their name and
password, and then click Join Room.

The guest must click on one more link to be able to join the My Room 
session. 

3) Once you click on Join Room, you see a notification on your My Room (as
shown in the following figure).
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The guest can join the video portion of the session by clicking on the video button. 

The guest can switch between audio and video mode by clicking on the video icon. 
They can also mute and end the call by clicking on the mute and end call icons 
respectively. 

The guest can show or hide their self-view by clicking on the video icons in the bottom part 
of the window. 

4) Open your My Room and accept the guest request. The video call is resized and
moved to the bottom row.

5) The guest is allowed into your room and can now participate in multi-user chat with
other participants in the room (as shown in the following figure from a browser).
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Appendix C: Configure USB Headsets 

This section provides more information on configuring USB 
devices to function with Mobility. Note that some headset 
manufacturers have built their own add-ins for Mobility, for 
instance, Jabra on Windows. In this case, the standard HID 
Add-Ins cannot be used at the same time. You can enable 
and disable add-ins in the Preferences → Extensions view. 

In general, on Windows if “Default Communication Device” is 
defined in Windows settings, it is selected over the “Default 
Device” by Mobility for calls when several audio devices are 
available (for example, USB headset and the integrated 
audio device on the PC). However, when using headsets, 
you can select a separate device than the headset for 
alerting incoming calls. 

The following examples provide more information on how 
to define a default communications device when a USB 
headset is available on the PC. 

It is recommended to select “Use Default” in the Media 
tab of Mobility Preferences 
for both input and output devices (as shown in the 
following figure). 

1) To define the default communications device, make sure that the Sound settings in
Windows pertaining to “Recording” and “Playback” devices are correctly configured.
From the Sound applet, select the Playback tab.

In this example, the user has a Plantronics BT300M (the USB dongle accompanying a
Voyager Legend UC) connected to their PC.
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2) Click Headset Earphone to highlight the device and click on the drop-down arrow next
to the Set Default button.

3) Select Default Communication Device. The following screen is displayed.
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4) Next, click the Recording tab.

5) Again, click on Headset Microphone, which represents the connected Plantronics
BT300M device, and click on the drop-down arrow next to the Set Default button.
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6) Select Default Communication Device.

7) Click OK to save the changes. The Sound window is dismissed, and your device is now
ready to be used by Mobility.

Appendix D: Third-Party Software and Copyright

The list of third-party software used in Mobility is available be from the following link: 

https://www.cisco.com/c/en/us/about/legal/open-source-
documentation- responsive.html?flt0_general-table0=UC-One 
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Appendix E: Acronyms and Abbreviations
This section lists the acronyms and abbreviations found in this document.  

ACB Automatic Callback 
ACD Automatic Call Distribution 

API Application Programming Interface 

CPU Central Processing Unit 

DLL Dynamic Link Library 

DM Device Management 

DND Do Not Disturb 

DTMF Dual-Tone Multi-Frequency 

ECACS Emergency Call Address Change Service 

EULA End-User License Agreement 

FAC Feature Access Code 

FAQ Frequently Asked Question 

FIPS Federal Information Processing Standard 

FMC Fixed-mobile Convergence 

GUI Graphical User Interface 

GW Gateway 

HD High Definition 

HID Human Interface Device 

IdP Identity Provider 

IM Instant Message 

IM&P Instant Messaging and Presence 

IP Internet Protocol 

LDAP Lightweight Directory Access Protocol 

MB Megabyte 

MWI Message Waiting Indication 

PIV Personal Identity Verification 

PSTN Public Switched Telephone Network 

OCS Office Communications Server (Microsoft) 

OS Operating System 

RAM Random Access Memory 

S4B Skype for Business 

SAML Security Assertion Markup Language 

SIP Session Initiation Protocol 
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SSO Single Sign-On 

UC Unified Communications 

UI User Interface 

URL Uniform Resource Locator 

UVS Video Server (BroadWorks) 

UX User Experience 

VDI Virtual Desktop Infrastructure 

VoIP Voice over IP 

WebRTC Web Real-Time Communication 

WiX Windows Installer XML 

XMPP Extensible Messaging and Presence Protocol 
Xsi Xtended Services Interface 
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Momentum Support
A team of expert support professionals are here to assist with technical issues, questions related to 
billing, feature usage, and service upgrades, as well as any other general inquiries you may have. 
Simply contact us and a representative will help you with your request.  

In order to provide optimal support, we recommend that the account owner (or an Authorized 
Contact) submit a ticket online or contact us via our toll-free support number regarding any critical or 
timely issues that may require troubleshooting. And always keep your account number handy to help 
us better assist you when you need us. 

Support by Phone: 800-658-2150
Live phone support is available. 

Online Support:  www.VexusFiber.com 

Documentation:  VexusFiber.com/TeleCloudU
TeleCloud is a free online knowledge base of training and support content on the Vexus 
Fiber website. The TeleCloudU library is easy to use and offers the latest information about 
Momentum’s best-in-class cloud services and features. 
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